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	S.No
	Tool Name
	Technology
	Write-up
	Evalulation
	URL

	1. 
	MaxQ
	Web Application
	Click
	Click
	http://maxq.tigris.org/

	2. 
	Abbot
	Java
	--
	--
	http://abbot.sourceforge.net/

	3. 
	LogiTest
	Web Application
	Click
	--
	http://logitest.sourceforge.net/logitest/index.html

	4. 
	Canoo WebTest
	Web Application
	Click
	Click
	http://webtest.canoo.com/webtest/manual/WebTestHome.html

	5. 
	Doit
	Web Application
	Click
	Click
	http://doit.sourceforge.net/

	6. 
	Qmtest
	Unix,Windows
	Click
	Click
	http://www.codesourcery.com/qm/qmtest

	7. 
	Solex
	Web Appplication
	Click
	Click
	http://solex.sourceforge.net/

	8. 
	Testmaker
	Web Application
	Click
	Click
	http://www.pushtotest.com/Downloads/downloadtmdoc.html

	9. 
	Web-Inject
	Web Application
	Click
	Click
	http://www.webinject.org/

	10. 
	XML Test Suite
	Web Application
	Click
	Click
	http://xmltestsuite.sourceforge.net/

	11. 
	QES
	UNIX, Mainframe,AS400, CICS
	--
	--
	http://www.qestest.com/qarch.htm

	12. 
	JFunc
	Java
	--
	--
	http://jfunc.sourceforge.net/

	13. 
	Watir
	Web Application
	Click
	Click
	http://wtr.rubyforge.org/


Open Source Tools – Functional and Performance Testing
Author : Pradeep G

Company: Cognizant
Open Source Testing:
Software Licensing -- Licensing is a major part of what open source and free software are all about, and it's one of the most complicated areas of law. This concise guide focuses on offering an in-depth explanation of Open Source functional testing tools, how they compare and interoperate. If you're an open source/free software tester, this book is an absolute necessity, bridging the gap between the open source tool and licensed tool functionalities. This guide also talks about the features of all open source testing tools with its limitations.

Description about Open Source Testing Tools

MaxQ:

MaxQ is a free web functional testing tool. It includes an HTTP proxy that records your test script, and a command line utility that can be used to playback tests. The proxy recorder automatically stores variables posted to forms, so testers don't have to write code by hand. The paradigm of MaxQ is similar to commercial web testing tools like Astra QuickTest or Empirix e-Test.

MaxQ is a free Web Functional Testing tool. It includes an HTTP proxy that records test script, and a command line utility that can be used to playback tests. The proxy recorder automatically stores variables posted to forms, so testers don't have to write that stuff by hand. It is written in Java, and uses Jython and JUnit. The generated test scripts are Python.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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Abbot:

Abbot provides a framework for testing your GUI regardless of the current state of your code. If you are doing test-first development with lots of unit testing, then Abbot can provide the developer the tools needed to write individual unit tests. If you have an existing code base without existing unit tests, you can use the scripting level of Abbot to start building functional test scaffolding around your application until it is sufficiently stable to support refactoring and addition of unit tests. 

In general, testing with Abbot consists of getting references to GUI components and either performing user actions on those components or making some assertions about their state. To facilitate this process, the framework provides ComponentReferences to get a handle on a GUI component (even when it may not yet exist), and extended Robot-like objects, which know how to perform user-level actions on various GUI components. These operations may be done from either a high-level script (useful for functional/acceptance testing) or directly from Java code (for example in a JUnit TestCase method).

Logitest:

LogiTest is the core application in the LogiTest suite. The LogiTest application provides a simple graphical user interface for creating and playing back tests.

(1)Tool Write-up :
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Canoo WebTest:

Canoo WebTest is a free open source tool for automated testing of web applications.It calls web pages and verifies the results, giving comprehensive reports on success and failure.

Canoo WebTest

=============

Description: 

Used for functional testing of web pages, WebTest is an open source testing framework built on top of HttpUnit. It allows tests to be defined in XML as Ant targets.  

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :


[image: image5.wmf]"Canoo - Evaluation 

Matrix.doc"


Doit:

Doit is a scripting tool and language for testing web applications that use forms. Doit can generate random or sequenced form fill-in information, report results (into a database, file, or stdout), filter HTML results, and compare results to previous results. The Doit software was contributed by the GuardedProfile Corporation under the GNU General Public License.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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QMTest:

QMTest is a tool to test software applications, such as a database, compiler, or web browser. QMTest features both an intuitive graphical user interface and a conventional command-line interface. The graphical user interface provides a convenient method for creating, managing, and executing tests, provides support for parallel test execution, and can be extended in a variety of ways.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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Solex:

Solex is a Web application testing tool built as a plug-in for the Eclipse IDE. It provides functions to record a client session, adjust it according to various parameters and replay it later typically in order to ensure non regression of the application's behaviour (with stress testing capabilities being added at a later stage).

By recording, we mean that Solex acts as an HTTP proxy and records all HTTP requests and responses going through the wire between a Web client (eg. a Web browser) and a Web server. The task of replaying a scenario consists in sending the previously recorded and eventually customized HTTP requests to the server and asserting each response.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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Test Maker:
TestMaker is a free open-source framework and utility for building intelligent test agents to check Web-enabled applications and Web Services for scalability, performance and functionality. TestMaker is a 100% Java application and runs everywhere Java runs, including Windows, Linux, Solaris, and Macintosh OS X. Requires Java 1.4.1 or greater.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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WebInject:

WebInject is a free tool for automated testing of web applications and services. It can be used to test any individual system component with an HTTP interface (JSP, ASP, CGI, PHP, Servlets, HTML Forms, etc), and can be used as a test harness to create a suite of [HTTP level] automated functional, acceptance, and regression tests. A test harness (also referred to as a test driver or a test framework) allows you to run many test cases and collect/report your test results.
WebInject can be used a complete test framework that is controlled by the WebInject User Interface (GUI). Optionally, it can be used as a standalone test runner (text/console application) which can be integrated and called from other test frameworks or applications.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :
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XMLTestSuite:

XmlTestSuite provides a powerful way to test web applications. Writing tests requires only a knowledge of HTML and XML. We want XmlTestSuite to be adopted by testers, business analysts, and web developers who don't have a java background. Check site structure:HTML pages are well formed and links are valid ,Check the content of pages:Use Javascript variables, XPath expressions, database queries,Check the way the site works:Run test scanarios, written in XML.

(1)Tool Write-up :
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(2)Tool Evaluation Matrix :

[image: image17.wmf]"Tool Evaluation 

Matrix _XML Test Suite.doc"


QES:

Architect is a complete automated software testing and software quality process management system that anyone can use to test and manage the quality of their applications.  It has the unique distinction of enabling non-technicians to capture and replay tests in Windows,  NT  as well as in the mainframe.  That means that as applications develop on the lower cost workstations,  tests can also develop on the workstation.   When the application moves to the mainframe, the same tests can validate and verify the application in its new environment.

Jfunc :

JFunc is an extension to the JUnit testing framework to make it easier for use with functional tests. Functional testing (also called integration testing) significantly differs from unit testing in a number of respects. Part of this project is dedicated towards putting together code to address these differences; the other part of this project is putting together methodologies for functional testing.
	Watir : 
Watir (Web Application Testing in Ruby) is a functional testing tool for web applications. It supports tests executed at the web browser layer by driving a web browser and interacting with objects on a web page. It uses the Ruby scripting language.

(1) Tool Write-up
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(2) Tool Evaluation matrix
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	Overall Evaluation Matrix


	Functional Testing Tool Characteristics
	WinRunner
	MaxQ
	Canoo WebTest
	Doit
	QMTest
	Solex
	TestMaker
	WebInject
	XML TestSuite
	WATIR

	
	Generation of editable test scripts by capturing application and user I/O activity
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	N
	Y
	N
	
	Real time data stream capture
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	N
	Y
	Y
	
	Network Interaction capture
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Text Checkpoint support
	Y
	N
	N
	N
	N
	N
	N
	Y
	Y
	Y
	
	Data Driver Interface support
	Y
	Y
	N
	N
	N
	N
	Y
	N
	Y
	Y
	
	Parameterized testing support
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	N
	Y
	Y
	
	Synchronization support
	Y
	N
	Y
	N
	N
	N
	N
	Not checked
	N
	N
	
	No practical limitation to fonts or sizes
	Y
	 
	N
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	
	Hot key capture
	Y
	N
	Y
	N
	N
	N
	N
	N
	Y
	N
	
	GUI object capture even if they are invisible
	Y
	N
	Y
	N
	N
	N
	N
	N
	N
	N
	
	Custom object capture
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Recording and checkpoints for all attributes of GUI objects
	Y
	N
	Y
	N
	Y
	N
	N
	N
	N
	N
	
	Referencing the coordinates of an object relative to the window in focus, rather than the whole screen
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Automatic switching from object level to bitmap recording when encountering non-standard objects
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	ODBC support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Usage of external DLL APIs as well as .exe files
	Y
	Y
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Error Recovery (e.g. Browser crash)
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Error Handling (ability to write handlers)
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Allows Error Tracking database
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Adaptability to various communication protocols (TCP/IP, IPX)
	Y
	 
	N
	N
	N
	N
	N
	N
	N
	N
	
	Ability to kick off scripts at a specified time; scripts can run unattended
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Wizard-driven database checkpoint
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	SAP support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	PeopleSoft Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Euro Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Y2K support
	Y
	 
	N
	N
	N
	N
	N
	N
	N
	N
	
	Delphi Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Power Builder Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Visual Basic Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Visual C++ Support
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	N
	
	Analog and Context Sensitive Recording
	Y
	Y
	N
	N
	N
	N
	N
	N
	N
	N
	
	Support for two or more families of Operating Systems
	Y
	Y
	N
	Y
	Y
	Y
	Y
	N
	N
	Y
	
	Support for different flavor of an Operating System
	Y
	Y
	N
	N
	N
	N
	N
	N
	N
	Y
	
	Support for different versions of Internet Explorer
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	Y
	
	Support for different versions of Netscape
	Y
	N
	Y
	N
	N
	N
	Y
	Y
	Y
	Y
	
	GUI and Character base convention support
	Y
	 
	N
	N
	N
	N
	N
	Y
	N
	N
	
	Password Encryption in scripts
	Y
	N
	Y
	Y
	Y
	Y
	Y
	N
	Y
	N
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Canoo WebTest is a free open source tool for automated testing of web applications


It calls web pages and verifies the results, giving comprehensive reports on success and failure.


Canoo WebTest


=============


Description: 


Used for functional testing of web pages, WebTest is an open source testing framework built on top of HttpUnit. It allows tests to be defined in XML as Ant targets.  


Site Reference:


http://webtest.canoo.com/webtest/manual/WebTestHome.html


_1164179697.doc


Canoo Web Test


1.0 Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		WinRunner

		Canoo



		Generation of editable test scripts by capturing application and user I/O activity

		Y

		Y



		Real time data stream capture

		Y

		Y



		Network Interaction capture

		Y

		N



		Text Checkpoint support

		Y

		N



		Data Driver Interface support

		Y

		N



		Parameterized testing support

		Y

		Y



		Synchronization support

		Y

		Y



		No practical limitation to fonts or sizes

		Y

		N



		Hot key capture

		Y

		Y



		GUI object capture even if they are invisible

		Y

		Y



		Custom object capture

		Y

		N



		Recording and checkpoints for all attributes of GUI objects

		Y

		Y



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		Y

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		Y

		N



		ODBC support

		Y

		N



		Usage of external DLL APIs as well as .exe files

		Y

		N



		Error Recovery (e.g. Browser crash)

		Y

		N



		Error Handling (ability to write handlers)

		Y

		N



		Allows Error Tracking database

		Y

		N



		Adaptability to various communication protocols (TCP/IP, IPX)

		Y

		N



		Ability to kick off scripts at a specified time; scripts can run unattended

		Y

		N



		Wizard-driven database checkpoint

		Y

		N



		SAP support

		Y

		N



		PeopleSoft Support

		Y

		N



		Euro Support

		Y

		N



		Y2K support

		Y

		N



		Delphi Support

		Y

		N



		Power Builder Support

		Y

		N



		Visual Basic Support

		Y

		N



		Visual C++ Support

		Y

		N



		Analog and Context Sensitive Recording

		Y

		N



		Support for two or more families of Operating Systems

		Y

		N



		Support for different flavor of an Operating System

		Y

		N



		Support for different versions of Internet Explorer

		Y

		Y



		Support for different versions of Netscape

		Y

		Y



		GUI and Character base convention support

		Y

		N



		Password Encryption in scripts

		Y

		Y



		Weightage

		100%

		





Supports – Y
Not Supports – N


1.1 Recommendations
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Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		QMTest



		Generation of editable test scripts by capturing application and user I/O activity

		Y



		Real time data stream capture

		Y



		Network Interaction capture

		N



		Text Checkpoint support

		N



		Data Driver Interface support

		N



		Parameterized testing support

		Y



		Synchronization support

		N



		No practical limitation to fonts or sizes

		Y



		Hot key capture

		N



		GUI object capture even if they are invisible

		N



		Custom object capture

		N



		Recording and checkpoints for all attributes of GUI objects

		Y



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		N



		ODBC support

		N



		Usage of external DLL APIs as well as .exe files

		N



		Error Recovery (e.g. Browser crash)

		N



		Error Handling (ability to write handlers)

		N



		Allows Error Tracking database

		N



		Adaptability to various communication protocols (TCP/IP, IPX)

		N



		Ability to kick off scripts at a specified time; scripts can run unattended

		N



		Wizard-driven database checkpoint

		N



		SAP support

		N



		People Soft Support

		N



		Euro Support

		N



		Y2K support

		N



		Delphi Support

		N



		Power Builder Support

		N



		Visual Basic Support

		N



		Visual C++ Support

		N



		Analog and Context Sensitive Recording

		N



		Support for two or more families of Operating Systems

		Y



		Support for different flavor of an Operating System

		N



		Support for different versions of Internet Explorer

		Y



		Support for different versions of Netscape

		N



		GUI and Character base convention support

		N



		Password Encryption in scripts

		Y



		Weight age
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Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		TestMaker



		Generation of editable test scripts by capturing application and user I/O activity

		Y



		Real time data stream capture

		Y



		Network Interaction capture

		N



		Text Checkpoint support

		N



		Data Driver Interface support

		Y



		Parameterized testing support

		Y



		Synchronization support

		N



		No practical limitation to fonts or sizes

		Y



		Hot key capture

		N



		GUI object capture even if they are invisible

		N



		Custom object capture

		N



		Recording and checkpoints for all attributes of GUI objects

		N



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		N



		ODBC support

		N



		Usage of external DLL APIs as well as .exe files

		N



		Error Recovery (e.g. Browser crash)

		N



		Error Handling (ability to write handlers)

		N



		Allows Error Tracking database

		N



		Adaptability to various communication protocols (TCP/IP, IPX)

		N



		Ability to kick off scripts at a specified time; scripts can run unattended

		N



		Wizard-driven database checkpoint

		N



		SAP support

		N



		People Soft Support

		N



		Euro Support

		N



		Y2K support

		N



		Delphi Support

		N



		Power Builder Support

		N



		Visual Basic Support

		N



		Visual C++ Support

		N



		Analog and Context Sensitive Recording

		N



		Support for two or more families of Operating Systems

		Y



		Support for different flavor of an Operating System

		N



		Support for different versions of Internet Explorer

		Y



		Support for different versions of Netscape

		Y



		GUI and Character base convention support

		N



		Password Encryption in scripts

		Y



		Weight age
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		Watir 



		http://wtr.rubyforge.org/ 



		Description: 



		Watir (Web Application Testing in Ruby) is a functional testing tool for web applications. It supports tests executed at the web browser layer by driving a web browser and interacting with objects on a web page. It uses the Ruby scripting language. 



		Requirement: 



		Windows (currently only supports Internet Explorer)






_1191397090.doc
		Functional Testing Tool Characteristics

		WATIR



		Generation of editable test scripts by capturing application and user I/O activity

		N



		Real time data stream capture

		Y



		Network Interaction capture

		Y



		Text Checkpoint support

		Y



		Data Driver Interface support

		Y



		Parameterized testing support

		Y



		Synchronization support

		N



		No practical limitation to fonts or sizes

		Y



		Hot key capture

		N



		GUI object capture even if they are invisible

		N



		Custom object capture

		N



		Recording and checkpoints for all attributes of GUI objects

		N



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		N



		ODBC support

		Y



		Usage of external DLL APIs as well as .exe files

		Y



		Error Recovery (e.g. Browser crash)

		Y



		Error Handling (ability to write handlers)

		Y



		Allows Error Tracking database

		Y



		Adaptability to various communication protocols (TCP/IP, IPX)

		N



		Ability to kick off scripts at a specified time; scripts can run unattended

		N



		Wizard-driven database checkpoint

		N



		SAP support

		N



		People Soft Support

		N



		Euro Support

		N



		Y2K support

		N



		Delphi Support

		N



		Power Builder Support

		N



		Visual Basic Support

		N



		Visual C++ Support

		N



		Analog and Context Sensitive Recording

		N



		Support for two or more families of Operating Systems

		Y



		Support for different flavor of an Operating System

		Y



		Support for different versions of Internet Explorer

		Y



		Support for different versions of Netscape

		Y



		GUI and Character base convention support

		N



		Password Encryption in scripts

		N



		Weight age
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Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		XML Test Suite



		Generation of editable test scripts by capturing application and user I/O activity

		Y



		Real time data stream capture

		Y



		Network Interaction capture

		N



		Text Checkpoint support

		Y



		Data Driver Interface support

		Y



		Parameterized testing support

		Y



		Synchronization support

		N



		No practical limitation to fonts or sizes

		Y



		Hot key capture

		Y



		GUI object capture even if they are invisible

		N



		Custom object capture

		N



		Recording and checkpoints for all attributes of GUI objects

		N



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		N



		ODBC support

		N



		Usage of external DLL APIs as well as .exe files
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1 Introduction


QMTest is a tool to test software applications, such as a database, compiler, or web browser. QMTest features both an intuitive graphical user interface and a conventional command-line interface. The graphical user interface provides a convenient method for creating, managing, and executing tests, provides support for parallel test execution, and can be extended in a variety of ways.


2 Installation 


QMTest requires python 2.2 or greater. Most GNU/Linux distributions come with Python, either as part of the base installation, or as an availble prepackaged add-on. The Windows version of Python is available for download from the http://www.python.org/.


After installing python, Download and execute the Windows installation package from www.codesourcery.com



3 Overview


Qmtest comes up with a set of base test classes written in Python language. Tests are created by creating instance of the available test classes provided by Qmtest. If the built-in functionality provided with QMTest does not serve the user needs, the user can extend the  QMTest base classes and create instances of the extension classes developed to create new tests. All extensions to QMTest take the form of Python classes.The extension classes created are placed in a location where QMTest can find it.


4 QMTest Concepts


This section presents the concepts that underlie QMTest's design. By understanding these concepts, you will be able to better understand how QMTest works. In addition, you will find it easier to extend QMTest to new application domains


4.1 Tests


Every test is an instance of some test class. The test class dictates how the test is run, what constitutes success, and what constitutes failure. For example, the command.ExecTest class that comes with QMTest executes the target application and looks at its output. The test passes if the actual output exactly matches the expected output.


The arguments to the test parameterize the test; they are what make two instances of the same test class different from each other. For example, the arguments to command.ExecTest indicate which application to run, what command-line arguments to provide, and what output is expected.


4.2 Resources


Some tests take a lot of work to set up. For example, a database test that checks the result of SQL queries may require that the database first be populated with a substantial number of records. If there are many tests that all use the same set of records, it would be wasteful to set up the database for each test. It would be more efficient to set up the database once, run all of the tests, and then remove the databases upon completion.


You can use a resource to gain this efficiency. If a test depends on a resource, QMTest will ensure that the resource is available before the test runs. Once all tests that depend on the resource have been run QMTest will destroy the resource.


Just as every test is an instance of a test class, every resource is an instance of a resource class. The resource class explains how to set up the resource and how to clean up when it is no longer needed. The arguments to the resource class are what make two instances of the same resource class different from each other. For example, in the case of a resource that sets up a database, the records to place in the database might be given as arguments


4.3 Context


When you create a test, you choose arguments for the test. The test class uses this information to run the test. However, the test class may sometimes need information that is not available when the test is created. For example, if you are writing compiler tests to verify conformance with the C programming language specification, you do not know the location of the C compiler itself. The C compiler may be installed in different locations on different machines.


A context gives users a way of conveying this kind of information to tests. The context is a set of key/value pairs. The keys are always strings


4.4 Test Results


A result is an outcome together with some annotations. The outcome indicates whether the test passed or failed. The annotations give additional information about the result, such as the manner in which the test failed, the output the test produced, or the amount of time it took to run the test.


4.5 Test Database


A test database stores tests, test suites, and resources. When you ask QMTest for a particular test by name, it queries the test database to obtain the test itself. QMTest stores a test database in a single directory, which may include many files and subdirectories.


A single test database can store many different kinds of tests. By default, QMTest stores tests, resources, and test suites in the test database using subdirectories containing XML files.


5 Available Test Classes


5.1 Test and Resource Classes


This section describes test classes and resource classes included with QMTest. 


5.1.1 Test Classes


command.ExecTest


The command.ExecTest test class runs a program from an ordinary executable file. Each test specifies the program executable to run, its full command line, and the data to feed to its standard input stream. ExecTest collects the complete text of the program's standard output and standard error streams and the program's exit code, and compares these to expected values specified in the test. If the standard output and error text and the exit code match the expected values, the test passes.


A command.ExecTest test supplies the following arguments:


Program (text field) 


The name of the executable file to run. command.ExecTest attempts to locate the program executable in the path specified by the path property of the test context.


Argument List (set of strings) 


The argument list for the program. The elements of this set are sequential items from which the program's argument list is constructed. command.ExecTest automatically prepends an implicit zeroth element, the full path of the program.


Standard Input (text field) 


Text or data to pass to the program's standard input stream. This data is written to a temporary file, and the contents of the file are directed to the program's standard input stream.


Environment (set of strings) 


The environment (i.e. the set of environment variables) available to the executing program. Each element of this argument is a string of the form "VARIABLE=VALUE".


command.ExecTest adds additional environment variables automatically.


In addition, every context property whose value is a string is accessible as an environment variable; the name of the environment variable is the name of the context property, prefixed with "QMV_" and with any dots (".") replaced by a double underscore ("__"). For example, the value of the context property "CompilerTable.c_path" is available as the value of the environment variable "QMV_CompilerTable__c_path".


Expected Exit Code (integer field) 


The exit code value expected from the program. If the program produces an exit code value different from this one, the test fails.


Expected Standard Output (text field) 


The text or data which the program is expected to produce on its standard output stream. The actual text or data written to standard output is captured, and command.ExecTest performs a bytewise comparison to the expected text or data. If they do not match, the test fails.


Expected Standard Error (text field) 


The text or data which the program is expected to produce on its standard error stream. The actual text or data written to standard error is captured, and command.ExecTest performs a bytewise comparison to the expected text or data. If they do not match, the 


test fails.


command.ShellCommandTest


command.ShellCommandTest is very similar to command.ExecTest, except that it runs a program via the shell rather than directly. Instead of specifying an executable to run and the elements of its argument list, a test provides a single command line. The shell is responsible for finding the executable and constructing its argument list.


Standard input and the environment are specified in the test. The test passes if the command produces the expected standard output, standard error, and exit code.


Note that most shells create local shell variables to mirror the contents of the environment when the shell starts up. Therefore, the environment set up by a command.ShellCommandTest, including the contents of the test context, are directly accessible via shell variables. The syntax to use depends on the particular shell.


command.ShellCommandTest has the same fields as command.ExecTest, except that the Program and Argument List properties are replaced with these:


Command (text field) 


The command to run. The command is delivered verbatim to the shell. The shell interprets the command according to its own quoting rules and syntax.


command.ShellScriptTest


command.ShellScriptTest is an extension of command.CommandTest that lets a test specify an entire shell script instead of a single command. The script specified in the test is written to a temporary file, and this file is interpreted by the specified shell or command interpreter program.


Standard input, the environment, and the argument list to pass to the script are specified in the test. The test passes if the script produces the expected standard output, standard error, and exit code.


Note that most shells create local shell variables to mirror the contents of the environment when the shell starts up. Therefore, the environment set up by a command.ShellScriptTest, including the contents of the test context, are directly accessible via shell variables. The syntax to use depends on the particular shell.


command.ShellScriptTest has the same fields as command.ExecTest, except that the 


Program property is replaced with:


Script (text field) 


The text of the script to run.


5.1.2 Test Targets

Test targets represent entities that QMTest uses to run tests.


Target Specification


Each target specification includes the following:


The name of the target. This is a name identifying the target, such as the host name of the computer which will run the tests. Target names should be unique in a single target file.


The target class. Similar to a test class, a target class is a Python class which implements a type of target. As with test classes, a target class is identified by its name, which includes the module name and the class name.


For example, thread_target.ThreadTarget is the name of a target class, provided by QMTest, which runs tests in multiple threads on the local computer.


QMTest includes several target class implementations. A target group name. The test implementor may choose the syntax of target group names in a test implementation. Target groups may be used to encode information about target attributes, such as architecture and operating system, and capabilities.


Optionally, a target specification may include additional properties. Properties are named and have string values. Some target classes may use property information to control their configuration. For instance, a target class which executes tests on a remote computer would extract the network address of the remote computer from a target property.


Target Classes


QMTest includes these target class implementations.


SerialTarget


The serial_target.SerialTarget target class runs tests one after the other on the machine running QMTest. If you use a SerialTarget, you should not also use any other targets, including another SerialTarget at the same time.


ThreadTarget


The thread_target.ThreadTarget target class runs tests in one or more threads on the machine running QMTest. The ThreadTarget can be used to run multiple tests at once.


ThreadTarget uses the following properties:


The concurrency specifies the number of threads to use. Larger numbers of threads will allow QMTest to run more tests in parallel. You can experiment with this value to find the setting that allows QMTest to run tests most quickly.


ProcessTarget


The process_target.ProcessTarget target class run tests in one more processes on the machine running QMTest. This target class is not available on Windows. Like ThreadTarget, ProcessTarget can be used to run multiple tests simultaneously.


In general, you should use ThreadTarget instead of ProcessTarget to maximize QMTest performance. However, on machines that do not have threads, ProcessTarget provides an alternative way of running tests in parallel.


ProcessTarget uses the following properties:


The concurrency specifies the number of processes to use. Larger numbers of processes will allow QMTest to run more tests in parallel. You can experiment with this value to find the setting that allows QMTest to run tests most quickly.


QMTest uses the path given by the qmtest property to create additional QMTest instances. By default, the path /usr/local/bin/qmtest is used.


RemoteShellTarget


The rsh_target.RSHTarget target class runs tests on a remote computer via a remote shell invocation (rsh, ssh, or similar). This target uses a remote shell to invoke a program similar to the qmtest command on the remote computer. This remote program accepts test commands and responds with results from running these tests.


To use RSHTarget, the remote computer must have QMTest installed and must contain an identical copy of the test database. QMTest does not transfer entire tests over the remote shell connection; instead, it relies on the remote test database for loading tests.


In addition, the remote shell program must be configured to allow a remote login without additional intervention (such as typing a password). If you use rsh, you can use an .rhosts file to set this up. If you use ssh, you can use an SSH public key and the ssh-agent program for this. See the corresponding manual pages for details.


RSHTarget uses all of the properties given above for ProcessTarget. In addition, RSHTarget uses the following properties:


The remote_shell property specifies the path to the remote shell program. The default value is ssh. The remote shell program must accept the same command-line syntax as rsh.


The host property specifies the remote host name. If omitted, the target name is used.


The database_path property specifies the path to the test database on the remote computer. The test database must be identical to the local test database. If omitted, the local test database path is used.


The arguments property specifies additional command-line arguments for the remote shell program. The value of this property is split at space characters, and the arguments are added to the command line before the name of the remote host.


For example, if you are using the ssh remote shell program and wish to log in to the remote computer using a different user account, specify the -l username option using the arguments property.


6 Procedure Of Creating a New User Defined Test


Creating  a new test involves the following steps.


· Creation of a new test class in Python extending the available Qmtest classes.


· Registering the newly created test class using qmtest register command.


· Creation of  Test using Qmtest GUI or Command Line Interface.


· Execution of the newly created test using GUI or Command Line Interface.


6.1 Extending QMTest

If the built-in functionality provided with QMTest does not serve all of your needs, you can extend QMTest. All extensions to QMTest take the form of Python classes. You can write new test classes, resource classes, or database classes in this way.


New test classes are derived from Test while new test database classes are derived from Database.


The classes from which new extensions are derived (like Test) are all themselves derived from Extension. The Extension class provides the basic framework used by all extension classes. 


6.1.1 Writing Test Classes


A test class is a Python class derived from Test. The test class must define an arguments variable, whose value is a sequence of Fields, and a Run function.


The arguments to the test are the inputs to the test. The Run function explains how to perform the test and how to determine whether or not it passed. For example, if you want to test that a compiler correctly compiled a particular source file, the source file would be an argument to the test while the Run would be responsible for running the compiler and the program generated by the compiler. The path to the compiler itself would be provided via the context , that is an input to the testing system that varies depending on the user's environment.


The Run function takes two arguments: the context and the result. The context object is an instance of Context. The result object is an instance of Result. 


Example Test Class Source
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Description of the example test class created:





The example test class created compares two text files. It takes the file path of the two files to be compared as arguments and gives the result of comparison as a message. 





The test class created is stored with an extension py as they are python classes.


6.2 Registering an Extension Class


To use your test or resource class, you must place the Python module file containing it in a directory where QMTest can find it. QMTest looks in three places when loading extension classes:


If the environment variable QMTEST_CLASS_PATH is defined, QMTest first checks any directories listed in it.


QMTest checks the configuration directory (the subdirectory named QMTest of a test database).


Finally, QMTest checks a standard directory. This directory, installed with QMTest, contains modules with the standard test classes. 


You should generally place module files containing your test classes in the test database's QMTest directory, unless you plan to use the test classes in more than one test database.


You must use the qmtest register command to register your new extension class. You must perform this step no matter where you place the module containing your extension class.


Register an extension class


qmtest register kind class-name 


Description


The qmtest register registers an extension class with QMTest. 


The kind argument tells QMTest what kind of extension class you are registering. If you invoke qmtest register with no arguments it will provide you with a list of the available extension kinds.


The class-name argument gives the name of the class in the form module.Class. where module is the name of the module (file name in which the new test class is defined) and Class is the name of the newly created test class.


QMTest will look for a file whose basename is the module name and whose extension is either py, pyc, or pyo.


Registering the Example test class created

1. Place the extension class in the Qmtest folder.


2. Set environment variable QMTEST_CLASS_PATH to C:\Python23\qm\tutorial\test\tdb;


3. From the test database folder, execute qmtest register command from the command prompt.
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4. Once the test class is registered with Qmtest, message confirming that will be displayed.


6.3 Creation of a New Test 



A new test can be created using the command line interface or Qmtest GUI.


Creating a Test using Command Line Interface


Syntax


qmtest create [ option ...] kind descriptor 


Description


The qmtest create creates a new extension instance. For example, this command can be used to create a new test or resource. For a list of the kinds of extensions supported by QMTest, run qmtest extensions. The kind must be one of these extension kinds.


The descriptor specifies an extension class and (optionally) attributes for that extension class. The form of the descriptor is class(attributes), where the attributes are of the form attr = "val". If there are no attributes, the parentheses may be omitted.


The class may be either the path to an extension file or a QMTest class name in the form module.class. If the class is the path to an extension file (such as an existing test or resource file), the class name used is the one provided in the file; otherwise the class 


named used is the name provided on the command line.


The attributes used to construct the extension instance come from three sources: the attributes in the extension file (if the class is the path to an extension file), the --attribute options provided on the command line, and the explicit attributes provided in the descriptor. If multiple values for the the same attribute name are provided, the value used is taken from the first source in the following list for which there is a value: the rightmost attribute provided in the descriptor, the extension file, or the rightmost --attribute present on the command line.


The new extension file is written to the file specified with the --output option, or to the standard output if no --output is specified.


The create command accepts these options:


-a name=value, --attribute name=value 


Set the target class argument name to value. The set of valid argument names and valid values is dependent on the extension class in use.


-o file, --output file 


Write a description of the extension instance to file.


Creating the test with GUI 


Include C:\Python23\Scripts; in the system path.

From the test database folder(refer screen shot), execute qmtest.py  gui command from the command prompt. 
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You will see output similar to: 


QMTest running at http://127.0.0.1:1158/test/dir


After a moment, a new web browser window will open, and you will see the QMTest graphical user interface (GUI). If a web browser window does not open, you will have to manually enter the URL that QMTest printed out (http://127.0.0.1:1158/test/dir in the example above) into your browser. Alterantively, you can edit your QM configuration file to tell QM how to invoke your browser and then start the GUI again.


As you can see, QMTest creates a graphical user interface using your web browser.


The page you see in your browser shows the contents of the test database. You can see that there are ten tests in the database namely exec0, exec1, exec2 etc.


Select File --> New Test from the File menu of the GUI.
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Enter the name of the test in the Test Name field and then select the test class, from the TestClass drop down. The test classes provided by Qmtest and the test classes created by the user and registered gets displayed in the Test Class drop down.(Here the example test class created and registered, new.der is selected by the user). Click Next.
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The two arguments of the created test are fileone and filetwo and the path of the text files to be compared should be provided. Enter the path of the files to be compared and click on Ok.
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Select Run--> This Test from the Run menu to execute the test created(newtest).
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The test results gets displayed.
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Click on Details link to see the results .
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7 Conclusion



Thus Qmtest can be used effectively to create new test classes extending the available base Qmtest classes. It cannot be compared to the conventional testing tools such as Winrunner  or Rational Robot, which employ record and playback mechanism to test software applications.
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Test Maker


TestMaker is a free open-source framework and utility for building intelligent test agents to check Web-enabled applications and Web Services for scalability, performance and functionality. TestMaker is a 100% Java application and runs everywhere Java runs, including Windows, Linux, Solaris, and Macintosh OS X. Requires Java 1.4.1 or greater.


Site Reference:


http://www.pushtotest.com/Downloads/downloadtmdoc.html
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Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		Web-Inject



		Generation of editable test scripts by capturing application and user I/O activity

		N



		Real time data stream capture

		N



		Network Interaction capture

		N



		Text Checkpoint support

		Y



		Data Driver Interface support

		N



		Parameterized testing support

		N



		Synchronization support

		Not checked



		No practical limitation to fonts or sizes

		Y



		Hot key capture

		N



		GUI object capture even if they are invisible

		N



		Custom object capture

		N



		Recording and checkpoints for all attributes of GUI objects

		N



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		N



		ODBC support

		N



		Usage of external DLL APIs as well as .exe files

		N



		Error Recovery (e.g. Browser crash)

		Y



		Error Handling (ability to write handlers)

		N



		Allows Error Tracking database

		N



		Adaptability to various communication protocols (TCP/IP, IPX)

		Y



		Ability to kick off scripts at a specified time; scripts can run unattended

		N



		Wizard-driven database checkpoint

		N



		SAP support

		N






		People Soft Support

		N



		Euro Support

		N



		Y2K support

		N



		Delphi Support

		Y



		Power Builder Support

		Y



		Visual Basic Support

		Y



		Visual C++ Support

		Y



		Analog and Context Sensitive Recording

		Y



		Support for two or more families of Operating Systems

		Y



		Support for different flavor of an Operating System

		Y



		Support for different versions of Internet Explorer

		Y



		Support for different versions of Netscape

		Y



		GUI and Character base convention support

		N



		Password Encryption in scripts

		N



		Weight age

		






_1164119845.doc
		XML Test Suite 



		http://xmltestsuite.sourceforge.net/ 



		Description: 



		XmlTestSuite provides a powerful way to test web applications. Writing tests requires only a knowledge of HTML and XML. We want XmlTestSuite to be adopted by testers, business analysts, and web developers who don't have a java background. 



		Requirement: 



		Windows 95/98/2000, Windows NT/2000, Linux, SunOS/Solaris 
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WEB INJECT



What is WebInject?

WebInject is a free tool for automated testing of web applications and services. It can be used to test any individual system component with an HTTP interface (JSP, ASP, CGI, PHP, Servlets, HTML Forms, etc), and can be used as a test harness to create a suite of [HTTP level] automated functional, acceptance, and regression tests. A test harness (also referred to as a test driver or a test framework) allows you to run many test cases and collect/report your test results.

WebInject can be used a complete test framework that is controlled by the WebInject User Interface (GUI). Optionally, it can be used as a standalone test runner (text/console application) which can be integrated and called from other test frameworks or applications.

Programming Language and Platforms

WebInject uses an XML API (interface). This means you can use WebInject without ever seeing it's internal implementation (no scripting or programming necessary to use it).

WebInject is written in Perl and can run (from Perl source code) on any platform that a Perl interpreter can be installed on (MS Windows, GNU/Linux, BSD, Solaris, MAC OS, and many more). Currently, binary executables of WebInject are only available for MS Windows. If you would like to run on other platforms, you must have a Perl interpreter and run it from the Perl source code.


Test Cases

Test cases are written in XML files (using XML tags and attributes) and passed to the WebInject engine for execution against the application/service under test. This abstracts the internals of WebInject's implementation away from the non-technical tester, while using an open architecture [written in Perl] for those that require more customzation or modifications.





Results/Reporting

An HTML file (results.html) is generated to display detailed results of the test execution. It is written into the directory that WebInject runs from and is overwritten each time the tool runs. The file contains data passed from the test case file (test case identifiers/descriptions, etc) as well as information generated from the test engine (test case pass/fail status, execution times, etc).

Results are also displayed in a window on the User Interface if you are running the WebInject GUI, and are sent to the STDOUT channel if you are running the WebInject Engine as a standalone (console) application.






Free and Open Source

WebInject is licensed under the GNU General Public License (GPL).

It is "Free" (as in freedom) as defined by the GNU Project and Free Software Foundation's (FSF) Free Software Definition, and also "Open Source" as defined by the Open Source Initiative's (OSI) Open Source Definition.

You are free to use WebInject in whatever manner you please at no cost. All source code is available to read and modify. However, if you make any modifications that you would like to publish, these modifications must also be covered under the same licensing terms. Please see the terms of the GNU GPL for more information.


The new .95 version of WebInject has been released. WebInject is a free tool for automated testing of web applications and services. It can be used to test any individual system component with an HTTP interface (JSP, ASP, CGI, PHP, Servlets, HTML Forms, etc), and can be used as a test harness to create a suite of [HTTP level] automated functional, acceptance, and regression tests.


Test Cases are created in XML Format .Web Inject reads the XML file which is present in  the sample application directory and starts processing the Tests and creates the HTML Report containing the information regarding each and every tests.


<testcases>

  <case id="1" description1="SAMPLE TEST CASE - load WebInject dev page" description2="verify string 'Corey Goldberg' exists in response" method="get" url="http://www.webinject.org/dev.html" verifypositive="Corey Goldberg" /> 


  <case id="2" description1="SAMPLE [NEGATIVE] TEST CASE - load WebInject dev page" description2="verify string 'bogus string' does not exist in response" method="get" url="http://www.webinject.org/dev.html" verifynegative="bogus string" /> 


  <case id="3" description1="SAMPLE TEST CASE THAT FAILS - load bogus page" description2="case should fail with an HTTP 404 (not found) error" method="get" url="http://www.webinject.org/bogus.html" /> 


  <case id="4" description1="SAMPLE TEST CASE THAT FAILS - valid page with bogus verification" description2="case should fail" method="get" url="http://www.webinject.org/dev.html" verifypositive="I am a bogus string" /> 


  <case id="5" description1="SAMPLE TEST CASE THAT FAILS - load bogus page" description2="case should fail with an HTTP 404 (not found) error" method="get" url="http://www.yahoosdsd.com" /> 


  </testcases>

SCREEN SHOTS


User Interface (webinjectgui)
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HTML Results Report (results.html)
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Recording Web Transactions With A Local Proxy
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HTTP/1.1 200 0K

Date: Fri, 23 Jan 2004 17:36:22 GMT

Server: Apache/1.3.27 (Unix) PHP/4.3.2 mod_ss1/2.8.12 OpenSSL/0.9.6b
< Powered By: PHP/4.3.2

-Accelerated-By: PHPA/1.3.3i2

Connection: close

Transier-Encoding: chunked

Content-Type: text/html
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Solex (Web Application Testing with Eclipse)


What is Solex ?


Solex is a Web application testing tool built as a plug-in for the Eclipse IDE. It provides functions to record a client session, adjust it according to various parameters and replay it later typically in order to ensure non regression of the application's behaviour (with stress testing capabilities being added at a later stage).


By recording, we mean that Solex acts as an HTTP proxy and records all HTTP requests and responses going through the wire between a Web client (eg. a Web browser) and a Web server. The task of replaying a scenario consists in sending the previously recorded and eventually customized HTTP requests to the server and asserting each response.


What can I do with Solex?


Solex can record HTTP messages by acting as a Web proxy. 


Recorded sessions can be saved as XML and reopened later. 


HTTP requests and responses are fully displayed in order to inspect and customize their content, thanks to replacement rules. 


Solex allows the attachment of extraction or replacement rules to any HTTP message content, HTTP header or URL parameter. 


Recorded requests can be filtered to remove or disable unwanted resources, like .jpg, .gif.


Solex allows the attachment of assertions to responses in order to validate a scenario during its playback. 


Solex can replay an HTTP session request by request or all requests at once. 


Playback results can be exported as XML with an optional XSL transformation.


Site Reference:

http://solex.sourceforge.net/
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		Doit: Simple Web Application Testing 



		http://doit.sourceforge.net/ 



		Description: 



		Doit is a scripting tool and language for testing web applications that use forms. Doit can generate random or sequenced form fill-in information, report results (into a database, file, or stdout), filter HTML results, and compare results to previous results, without having to manually use a web browser. It uses a console-based web client tool (like Curl or Wget) to send and receive HTTP requests and responses respectively. 



		Requirement: 



		You must have Perl 5 or greater and the appropriate Perl modules (detailed in Doit manual) installed on your system before you can use SPL.






_1164109384.doc


MaxQ


MaxQ is a free web functional testing tool. It includes an HTTP proxy that records your test script, and a command line utility that can be used to playback tests. The proxy recorder automatically stores variables posted to forms, so testers don't have to write code by hand. The paradigm of MaxQ is similar to commercial web testing tools like Astra QuickTest or Empirix e-Test.


MaxQ is a free Web Functional Testing tool. It includes an HTTP proxy that records test script, and a command line utility that can be used to playback tests. The proxy recorder automatically stores variables posted to forms, so testers don't have to write that stuff by hand. It is written in Java, and uses Jython and JUnit. The generated test scripts are Python.


1.0 Tool Evaluation Matrix


		Functional Testing Tool Characteristics

		WinRunner

		MaxQ



		Generation of editable test scripts by capturing application and user I/O activity

		Y

		Y



		Real time data stream capture

		Y

		Y



		Network Interaction capture

		Y

		



		Text Checkpoint support

		Y

		N



		Data Driver Interface support

		Y

		Y



		Parameterized testing support

		Y

		Y



		Synchronization support

		Y

		N



		No practical limitation to fonts or sizes

		Y

		



		Hot key capture

		Y

		N



		GUI object capture even if they are invisible

		Y

		N



		Custom object capture

		Y

		N



		Recording and checkpoints for all attributes of GUI objects

		Y

		N



		Referencing the coordinates of an object relative to the window in focus, rather than the whole screen

		Y

		N



		Automatic switching from object level to bitmap recording when encountering non-standard objects

		Y

		N



		ODBC support

		Y

		N



		Usage of external DLL APIs as well as .exe files

		Y

		Y



		Error Recovery (e.g. Browser crash)

		Y

		N



		Error Handling (ability to write handlers)

		Y

		N



		Allows Error Tracking database

		Y

		N



		Adaptability to various communication protocols (TCP/IP, IPX)

		Y

		



		Ability to kick off scripts at a specified time; scripts can run unattended

		Y

		N



		Wizard-driven database checkpoint

		Y

		N



		SAP support

		Y

		N



		PeopleSoft Support

		Y

		N



		Euro Support

		Y

		N



		Y2K support

		Y

		



		Delphi Support

		Y

		N



		Power Builder Support

		Y

		N



		Visual Basic Support

		Y

		N



		Visual C++ Support

		Y

		N



		Analog and Context Sensitive Recording

		Y

		Y



		Support for two or more families of Operating Systems

		Y

		Y



		Support for different flavor of an Operating System

		Y

		Y



		Support for different versions of Internet Explorer

		Y

		Y



		Support for different versions of Netscape

		Y

		N



		GUI and Character base convention support

		Y

		



		Password Encryption in scripts

		Y

		N



		Weightage

		100%

		35%





Supports – Y
Not Supports – N


1.1 Recommendations


MAXQ should be an ideal tool when compared to WebInject as - paradigm of MaxQ is similar to commercial web testing tools like Astra QuickTest or Empirix e-Test.
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LogiTest 

LogiTest is an open source application suite which can be used to test web sites and web applications.


Testing applications is crucial to providing user's with the best and most stable application possible. Unfortunately there are very few applications at this time for testing Internet-based applications. This is the gap that the LogiTest suite fills.


The core application in the LogiTest suite. The LogiTest application is used to record and playback single tests. LogiTest can be used to create functional and regression test for web applications using a simple graphical user interface.


Features


LogiTest has the following features:


Open source and free 


Easy-to-use user interface 


Tests are XML documents 


HTTP, HTTPS, and file protcols 


Cookies 


Browser history 


Multiple views of Internet resources (browser, formatted source code, DOM tree) 


Scriptable through Bean Scripting Framework 


LogiTest  which is a free open source Testing Tool can be downloaded from www.logitest.org    

Getting Started


There are two ways to run the LogiTest application:


If you are using Windows or X Windows (or some other *NIX GUI) you should be able to double click the LogiTest.jar application to execute LogiTest. You can also execute LogiTest with java -jar LogiTest.jar. 


Navigate to the LogiTest/bin directory and execute the run.bat file for Windows, or the run.sh file for UNIX/Linux (Note: UNIX/Linux users will need to change the executable bit with chmod u+x run.sh.) 


A new untitled test will automatically be created.


Note: As of version 0.6 all preferences will be stored in your home directory in a subfolder .logitest.
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First you will need to add some resources to the test. To add a resource enter the desired URL in the browser and click "Go" (or press return.) Once the page is displayed, click the plus icon [image: image2.png]



to append it to the Test's resource list. 
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You can also add a resource by right-clicking the Test name and selecting "Add...".
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Enter the URL to the resource or click the "Browse..." button to select a local file. You can select a request method ("GET" and "POST" methods are supported) as well as specify a delay time in milliseconds. The delay time will be used to pause before the resource is loaded. You can use this to emulate pauses by users.
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Resources can include name/value pairs which will be submitted as request headers or parameters during playback. To add a name/value pair right click the table and select "Add".


Once you have added a resource, you will need to add one or more testlets to that resource. Testlets provide test cases. LogiTest comes with two Testlets, but it is easy to add more.


To add a testlet, right-click on the resource you would like to add the testlet to and select the "Add..." option. A dialog will appear with the available testlets. Select the testlet and click "OK".
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You must then specify the parameters for the testlet.


In the screenshot below the testlet is configured to locate the text "User's Guide" in the document path "html/head/title". You can enter any Perl 5 regular expression in the expect field and it will be evaluated at test time. The path field requires a path to the element or attribute within the document similar to XPaths (in fact the path syntax is a subset of the XPath specification.) For more information on paths, see the Using Paths section of this user's guide.


You can also specify that the testlet should check all of the children below the specified path to locate the text by checking the Recursive check box. (Note: attributes are not currently tested in recursive mode.)
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You can add as many resources and tests as you would like. You can also set the name of the Test and add a description at any time by right-clicking on the Test.
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You are now ready to execute your test. You may want to save your test now if you have not already done so by clicking on the "Save" icon or selecting the File->Save menu item.


To execute the current test, click the "Play" icon on the toolbar or select the Run->Play menu item.
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Testlets which pass will be represented by a green "T", while testlets that fail will be represented by a red "T". Untested testlets are represented by a black "T". You can also disable tests by right-clicking on the Testlet and selecting the "Disable" option. The testlet will then be represented by a grey "T" until it is enabled again, at which time it will display the color of the last tested result.


Test results will also be printed in the lower split pane.
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Resources and testlets can be cut and pasted from the test tree to be configured to playback in any order. The test tree also supports unlimited undo.


Scripting


LogiTest can be controlled with scripting languages through IBM's Bean Scripting Framework (BSF). Any scripting language which supportes BSF can be used to control LogiTest.


To execute a script select the Run menu item from the Script menu. You will be prompted to load a script. The script that you load will be executed immediately if the scripting language is installed. Currently LogiTest supports scripting with JavaScript and Python.


The following objects and methods are available for scripting:


		Object

		Method

		Description



		logitest

		

		The LogiTest application object.



		logitest

		getTest

		Get the current org.logitest.Test object.



		logitest

		getBrowser

		Get the browser component.



		logitest

		getConfiguration

		Get the current Configuration.



		logitest

		newTest

		Create a new test. If the current test is unsaved then a dialog will appear giving the option to save the current test.



		logitest

		open

		Display a dialog to open a test.



		logitest

		save

		Save the current test.



		logitest

		saveAs

		Save the current test, displaying a file dialog first.



		logitest

		revert

		Revert to the last saved version of the test.



		logitest

		play

		Play the current test.



		logitest

		stop

		Stop the current test.



		logitest

		viewSource

		View the current page's source.



		logitest

		viewHeaders

		View the current page's headers.



		logitest

		viewCookies

		View the current cookies in memory.



		logitest

		back

		Go back in the browser's history.



		logitest

		forward

		Go forward in the browser's history.



		logitest

		properties

		Show the properties dialog.





Using Paths


LogiTest supports locating elements in a document with XPath-like paths. The following path elements are supported:


		Element

		Example

		Refers To



		/

		html/body

		The <body> nested in the <html> element.



		*

		html/*

		All elements nested within the <html> element.



		[n]

		html/table[1]

		The second table element nested within the the <html> element.



		@

		html/table@border

		The border attribute of any table element nested within the <html> element.





More examples:


		Example

		Refers To



		html/table[0]@border

		The border attribute of the first table nested within the <html> element.



		html/*/h1[2]

		The third <h1> element nested within any element which is nested directly in the <html> element.



		html/body/table[1]/tr/td[0]@align

		The align attribute of the first <td> element nested within any <tr> element in the second <table> element nested within any body element nested within any html element





A few notes about paths:


Path indexes, also known as predicates (i.e. [1]) start at 0. Thus, 0 refers to the first element in a document swith the specified name. 


Attributes should only be applied to the last part of a path. 


Creating Testlets


It is possible (and likely) that there will be times when the testlets provided with LogiTest will not provide the logic required to properly test your applications. The good news is that creating your own Testlet is easy.


Implementing Your Testlet


Custom testlets must extend from the Testlet base class. The Testlet base class is defined as follows:


public abstract class Testlet implements Editable{



public String getProperty(String name);



public int getState();



public void setState(int state);



public boolean isEnabled();



public void setEnabled(boolean enabled);



public abstract boolean test(Resource resource) throws Exception;



public void readConfiguration(Element element);



public void writeConfiguration(Element element);



public String toString();


}


Note: See the API documentation for full JavaDoc notes. 


Here are the descriptions of each method:


public String getProperty(String name)

Return a relavent property value. Standard properties are (as defined in the Testlet interface): 


DISPLAY_NAME - A user readable display name for the Testlet.
DESCRIPTION - A short description of the Testlet.
AUTHOR - The Testlet author's name.
VERSION - The version of the Testlet. 


public int getState()
public void setState(int state) 


Accessors for the last state of the Testlet. Possible values are defined in the Test class (UNTESTED, PASSED, FAILED).


public boolean isEnabled()
public void setEnabled(boolean enabled) 


Accessors for the enabled state of the Testlet. If this method returns true then the Testlet will not be executed at test time.


public boolean test(Resource resource) throws Exception

The actual test method. You must override this method and return true if the test passes or false if the test fails. This method can throw any Exception.


public void readConfiguration(Element element)
public void writeConfiguration(Element element) 


Read and write the configuration for the testlet. The configuration will be stored with the Test (and in XML format). The default behavior of these methods is to do nothing. Testlet implementations which want to load and store configuration information should override these methods. The element argument is a JDOM Element. The name of this element is currently LogiTest:testlet, but this should not matter to the testlet as the testlet should only add sub elements.


For an example of a testlet which loads and saves information, see org.logitest.testlet.ExpectTestlet.


public String toString()

Return a String reprsentation of the testlet which is human readable. The AbstractTestlet provides an implementation of this method which returns the DISPLAY_NAME property value if it exists or the testlet class name if the DISPLAY_NAME property is not set.


Custom Testlets must also provide implementations for the methods in the Editable interface. These methods are provided for displaying user interfaces for editing testlets.


public interface Editable{



public boolean save();



public void revert();



public Component getEditor();



public String getEditorTitle();


}


Note: See the API documentation for full JavaDoc notes. 


Here are the descriptions of each method:


public boolean save()

Save the current editor's values to the testlet's internal fields. This method can return false to indicate that the save failed.


Note: this method should not persist the testlet to a storage system, it should merely update the internal fields. See the writeConfiguration() method for saving to a persistant storage system.


public void revert()

Revert the GUI to the internal data of the testlet.


Note: this method should not load testlet from a persistant storage system, it should merely update the GUI with the values from the internal fields. See the readConfiguration() method for loading from a persistant storage system.


public Component getEditor()

Get a GUI component suitable for editing the testlet. While a Component must be returned, testlet authors are encouraged to use Swing for their testlet's user interface.


public String getEditorTitle()

Return a String suitable for displaying in an editor window's title bar.


Registering Your Testlet


In order for the LogiTest application to recognize your Testlet, you must include it in the classpath and add an entry to the config.xml file (i.e. <LogiTest:testlet name="My Testlet" id="mypackage.MyTestlet"/>). The config.xml file is located in LogiTest.jar. You can open this file and extract the default config.xml file with any ZIP tool. Add your testlet to the configuration and save it back in the LogiTest.jar file.


Standards Support


Support for the following standards is either already included in LogiTest or is in the process of being added:


RFC 2109 - HTTP State Management Mechanism 
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What is MaxQ?


MaxQ is a web functional testing tool. It has an HTTP proxy that records a test script, including values posted to web forms. Scripts can then be "played back" using a command-line utility. In a nutshell, you use the proxy to record your actions when browsing a site. These actions can then be repeated automatically using the scripting tool.


Programming Language and Platforms


The generated test scripts as a result of recording are Python, which could be customized.  MaxQ is a platform independent tool.


MaxQ is built on a number of existing free software packages: 


· Jython is used as the scripting engine. When a test is recorded, a python script is generated. Jython is used to run the script (thereby running the test). Jython provides the ability to invoke regular Java classes as well as python scripts. 


· JUnit is used as the testing library. MaxQ includes a base test class, HttpTestCase, that the test scripts subclass. This class is a subclass of the JUnit TestCase class, so all the assertion methods available in a JUnit test are available in your python test script. 


· Jakarta Commons HttpClient is used as the HTTP library. HttpClient transparently stores and sends Cookies, which is essential for doing web application testing, since most application servers use cookies for identifying user sessions. 


How MaxQ works?


After you install MaxQ, you're ready to start recording tests. 


· Start MaxQ. When MaxQ starts, it runs a HTTP proxy on port 8090 (port is configurable). 


· Configure your web browser to use localhost:8090 as its HTTP proxy. 


· Select File->New from the MaxQ GUI 


· Select Test->Record from the MaxQ GUI 


· Use your web browser to test the site. Each time you make an HTTP request, some python script is generated in the MaxQ editor window. When you submit a web form, the GET/POST arguments are automatically recorded in the test script. 


· Select Test->Stop Recording from the MaxQ GUI when you're done testing. This will prompt you to save the script to a file. 


Now you're ready to run the test. You can run the test from the GUI by simply selecting Test->Run, or you can run the test from the command line.

How to install and start MaxQ?


Installation


· Install Java 1.2 or later. Make sure java is in your PATH (or edit the included max.bat or max.sh scripts to point to the full path to your java binary) 


· Unzip the maxq zip file somewhere. The directory you unpack this zip into will be referred to as $MAXQ_HOME 


· Edit your PATH environment variable to include $MAXQ_HOME/bin 


Starting MaxQ


Sample scripts maxq and maxq.bat are provided in the bin directory for your convenience. Feel free to modify these scripts to suite your needs (e.g. set PATH or CLASSPATH as needed). 


Unix:
maxq [-port port] [-path python_include_path] [-q] [-debug] [-urlreplace url1 url2] [-run file1.py file2.py] 

Windows:
maxq.bat [-port port] [-path python_include_path] [-q] [-debug] [-urlreplace url1 url2] [-run file1.py file2.py] 

maxq.bat with no arguments will start the MaxQ GUI, and start the proxy server running on port 8090. 


Command Line Options: 


		Option

		Example

		Purpose



		-port

		-port 8000

		specifies the port the HTTP proxy should listen on



		-path

		-path c:/myproject/mytests 

		specifies the PYTHONPATH, which is where Jython looks for included python scripts. this is useful if you plan to write resuable script libraries for common routines in your tests (e.g. function to log a user into your web site). 



		-q

		-q

		quiet mode. only useful in conjunction with -run. if present, MaxQ will only generate output if a test fails. useful if you want to supress output for running tests from a cron job.



		-debug

		-debug

		debug mode. only used when recording a new test. will output some debugging information about which URLs have been recorded by the proxy. This is primarily useful when reporting bugs in MaxQ to me, but you're welcome to turn it on if you want to see what URLs are being trapped by the proxy.



		-urlreplace url1 url2

		-urlreplace localhost:8000 stage.myhost.com

		Replaces url1 with url2 during get/post calls during test playback. This is useful when you are recording your test against your local workstation during development, but would like to run the test suite against a different target server (e.g. your staging server). This is a simple string search/replace. It is case sensitive. This flag is only useful when running back tests with the -run option.



		-run [test files]

		-run test1.py test2.py test3.py

		runs the test scripts specified. when this option is present, the GUI and proxy server will not start.





Recording and Running Tests


Recording Tests


· Start MaxQ. Specify the -port option if you want the proxy to run on a port other than the default (8090) 


· Select File->New. 


· Select Test->Start. This will generate some starting python code in the main window. 


· Configure your web browser to use localhost:8090 as an HTTP proxy. The exact steps for doing this depends on which platform/browser you use. On MSIE 5 for Windows, do this: 


· From MSIE, select Tools->Internet Options 


· Click the Connections tab 


· Click the LAN Settings button at the bottom 


· Click the Use a proxy server checkbox 


· In the Address box, enter: localhost 


· In the Port box, enter: 8090 (or the custom port you specified) 


· Click OK 


NOTE: When you exit MaxQ, make sure to configure your browser to no longer use a proxy. Otherwise it will be unable to request pages. 


· Begin hitting the web pages you want to test. As you click on links, or submit forms, python code should be being generated in the MaxQ window. 


· When you're done testing, select Test->Stop Recording. You'll be prompted to enter a filename where the test script will be saved. We suggest using the file extension .py for these files. 


Running Tests


From the GUI: 


· Start MaxQ 


· Select File->Open and load the script file you wish to run 


· Select Test->Run to run the script. A dialog box will open with the output from the test run. 


From the command line: 


See the installation page for details. Basically you start MaxQ with the -run flag, and pass in the file names of the script file(s) you wish to run. For example: 


maxq.bat -run mytest.py


Running tests against a different server 


Sometimes it's useful to run a test against a server other than the one you recorded the test on. For example, I usually record my tests against my local PC, but would like to re-run the test suite against my staging server before I deploy changes live. MaxQ provides a -urlreplace switch to make this possible. This flag should be used in conjunction with the -run switch. For example: 


maxq.bat -urlreplace localhost:8000 stage.mydomain.com -run mytest.py


Any get() and post() method calls in mytest.py that contain the string localhost:8000 would have that string replaced with stage.mydomain.com during playback. The test file itself is not modified on disk. 


Editing Tests


- Anatomy of a Test Script
- The HttpTestCase class
- Adding SQL to tests
- Writing Library Scripts 



Anatomy of a MaxQ Test Script 


When you record a script, the output will look something like this: 


 1: # imports


 2: from com.bitmechanic.maxq import HttpTestCase, EditorPane


 3: from junit.textui import TestRunner


 4: from java.util import *


 5: 


 6: # defintition of test class


 7: class MaxQTest(HttpTestCase):


 8:     def __init__(self):


 9:         HttpTestCase.__init__(self, "")


10: 


11:     def runTest(self):


12:         self.get("http://www.google.com/")


13:         self.assertEquals(200, 



self.getResponse().getStatusCode())


14: 


15:    self.get("http://www.google.com/images/logo.gif")


16:    self.assertEquals(304, self.getResponse().getStatusCode())


17: 


18: 


19:         list = HashMap()


20:         list.add(NameValuePair("hl", "en"))


21:         list.add(NameValuePair("q", "testing+tools"))


22:         self.get("http://www.google.com/search", list)


23:    self.assertEquals(200,self.getResponse().getStatusCode())


24: 


25: ##########################################


26: 


27: # Code to load and run the test


28: test = MaxQTest()


29: test.runTest()


The script is simply python code. But if you're like me, you have no idea how python works. The table below should help clarify what this code means from a Java perspective. 


		lines

		purpose



		1

		comment. all lines starting with # are comments.



		2-4

		import statements. notice how we can import Java packages into the python namespace. these classes must be in the CLASSPATH of the script that starts MaxQ (e.g. maxq.bat), so if you wish to use your own classes, make sure to edit the CLASSPATH accordingly.



		7

		class declaration. this line tells python that the rest of the block is part of a class named MaxQTest that subclasses the Java class HttpTestCase. note that Jython lets us transparently subclass Java classes from python code. that was the primary reason python was chosen as the scripting language.



		8-9

		class constructor. calls the constructor of our parent class. note that python uses the word self to denote the current instance of the class. it's equivalent to this in Java. you shouldn't need to edit this section. 



		11

		start of our test method. MaxQ records the session as one long test function. you can break up these function into pieces if you wish.



		12

		we request Google's home page. get() is a method in the HttpTestCase class that we subclassed.



		13

		run a JUnit assertion. MaxQ automatically inserts an assertion that verifies that the HTTP response code is the same as the one it received when the test was recorded.



		19-21

		when we submitted the search form at Google, MaxQ created a ArrayList in the script, and filled in the variables that were sent in the QUERY_STRING. similar code would be written if this were a POST.



		22

		note the second argument to get() that passes in the list object. since it's a GET request, those variables will be formed into a QUERY_STRING



		25

		comment line used to visually denote the end of our test class



		28

		this line instantiates our test class. this is the first real line of code that executes during test playback (besides the import statements)



		29

		invokes our test method. note that there's _no_ magic going on here. this test script stands alone. what makes the script useful is that it's subclassing the JUnit TestCase class, and has a Java HTTP library sitting behind it. but at this point control flow goes straight to line 11. you could rename the method name in line 11 and 29, and as long as they matched, the script would still run.





OK, so now what? Well, once the script has been recorded, you can pretty much edit it to your choosing. Consider these modifications: 


add a print statement

11:     def runTest(self):


12:         print "I'm requesting the Google home page!"


13:         self.get("http://www.google.com/")


14:         self.assertEquals(200, self.getResponse().getStatusCode())


add another assertion

11:     def runTest(self):


12:         self.get("http://www.google.com/")


13:         self.assertEquals(200, self.getResponse().getStatusCode())


14:         self.assertTrue(self.responseContains("Make Google Your Homepage"))



HttpTestCase class 


HttpTestCase is a subclass of the JUnit TestCase class. You can call any methods that are in that class. 


It also defines additional utility methods: 


  void get(String url)


  void get(String url, Map args)


  void post(String url)


  void post(String url, Map args)


  void responseOK()   (throws Error if response not 200, 302, or 304)


  boolean responseContainsURI(String uri)  (used to check for redirects)


  boolean responseContains(String text)    (check for string in response HTML)


  void printResponse()                     (prints HTML response to STDERR)



Adding SQL to Tests 


Most web applications use a SQL database. MaxQ provides a utility class, DBUtil to simplify adding SQL to your tests. 


To use this class: 


· Make sure the JAR for your JDBC driver is in your CLASSPATH. You may want to edit the CLASSPATH in maxq.bat 


· Add: from com.bitmechanic.maxq import DBUtil to the top of your test script 


· Call: db = DBUtil("driver name", "url", "username", "password") to open a connection to the database 


· Call any of the methods in the class (e.g. execute) 


· Call: db.close() at the end of your script to close the database connection. 


Consider this example: 


# imports


from com.bitmechanic.maxq import HttpTestCase


from com.bitmechanic.maxq import DBUtil


from junit.textui import TestRunner


from java.util import HashMap


# defintition of test class


class MaxQTest(HttpTestCase):


    def __init__(self):


        HttpTestCase.__init__(self, "")


    def runTest(self):


        # open connection to database


        db = DBUtil("org.gjt.mm.mysql.Driver", 


             "jdbc:mysql://crankshaft.bitmechanic.com:3306/mydb", "myuser", "mypw")


        self.get("http://www.bitmechanic.com/")


        self.assertEquals(200, self.getResponse().getStatusCode())


        val = db.loadVal("select max(id) from contact")


        self.assertTrue(val > 0)


        # insert a row


        rows = db.execute("insert into sku (name) values ('test333')")


        self.assertEquals(rows, 1)


        # delete a row


        rows = db.execute("delete from sku where name = 'test333'")


        self.assertEquals(rows, 1)


        # close connection


        db.close()


##########################################


# Code to load and run the test


test = MaxQTest()


test.runTest()



Writing Library Scripts 


If your site has repetitive functionality, or functionality that requires the user to be in a certain state (e.g. logged into the site), then your recorded scripts will likely contain duplicate requests. In order to improve the maintainability of the tests, you probably want to refactor those routines into test libraries. 


Consider this script that logs into a bug database: 


 1: # imports


 2: from com.bitmechanic.maxq import HttpTestCase


 3: from junit.textui import TestRunner


 4: from java.util import HashMap


 5: import mantis


 6: 


 7: # defintition of test class


 8: class GetTest(HttpTestCase):


 9:     def __init__(self):


10:         HttpTestCase.__init__(self, "")


11: 


12:     def testHome(self):


13:         print "Testing mantis lib"


14:         mantis.login(self)


15:         self.get("http://www.bitmechanic.com/mantis/main_page.php")


16:         self.assertTrue(self.responseContains("Logged in"))


17:         mantis.logout(self)


18: 


19: ###########################################################################


20: 


21: # Code to load and run the test


22: test = GetTest()


23: test.testHome()


Note line 5: import mantis. That tells Jython to look for a file named mantis.py. Use the -path flag to MaxQ to specify a search path for this file. 


On line 14 we invoke a method in the mantis library file. The syntax is [package name].[method name]. We pass in self so the library file can make HTTP requests within our same HTTP session (and consequently have access to any cookies we've stored). 


Here's the source to mantis.py 


 1: from java.util import HashMap


 2: 


 3: #


 4: # Login to mantis


 5: #


 6: def login(test):


 7:     print "Logging in user"


 8:     map = HashMap()


 9:     map.put("f_username", "scott")


10:     map.put("f_password", "notmypw")


11:     test.post("http://www.bitmechanic.com/mantis/login.php", map)


12:     test.assertTrue(test.responseContains("Click here to proceed"))


13: 


14: #


15: # Logout of mantis


16: #


17: def logout(test):


18:     print "Logging out user"


19:     test.get("http://www.bitmechanic.com/mantis/logout_page.php")


20:     test.assertTrue(test.responseContains("Logged Out.."))



